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This tutorial analyzes the hysteresis of the conductance–gate-voltage (G–Vg) curves of an 
InAs nanowire FET, using the density-gradient theory to add the effect of quantum 
confinement to the conventional drift–diffusion formulation, without a large increase of 
computational costs. The hysteresis is caused by the dynamic charging effects of fast and 
slow semiconductor–oxide interface traps of continuous energy distributions and of both 
donor and acceptor types. The capture probability is modeled as thermally activated with 
a barrier height that varies with the trap energy level. The qualitative behavior and the 
order of magnitude of the computed G–Vg curves under various voltage ramping 
conditions agree well with simulation and experiment results found in the literature.

Introduction

The effect of surface states plays an important role on the electronic behavior of nanowires. 
This tutorial follows the approach described in the reference paper (Ref. 1) to compute the 
conductance as a function of the gate voltage history of an InAs nanowire FET. Instead of 
solving Schrödinger–Poisson equations, the density-gradient theory (as reviewed in 
Ref. 2) is used to add the effect of quantum confinement in a computationally efficient 
manner.

Model Definition

The model computes the conductance and the Fermi level relative to the conduction band 
edge, to be compared with Fig. 3 in Ref. 1. 

The Semiconductor interface is used to describe the governing physics. This approach is 
not exactly the same but is in close correspondence with the one described in Ref. 1 (more 
details later). Some parameters for our approach have to be guessed. In particular, the bulk 
material properties of InAs are taken from Ref. 3 and the density-gradient oxide barrier 
parameters from Ref. 4. The section Modeling Instructions lists all the parameters used in 
the model. The density-gradient parameters are directly entered in the physics features.

In the experiment reported in Ref. 1, the gate voltage is held at an initial voltage for a long 
time for the system to reach equilibrium. Then the gate voltage (Vg) is ramped to a peak 
or valley voltage and then immediately ramped back to the initial voltage. During this 
voltage ramp, the conductance (G) is measured and recorded. Different voltage ramp rates 
are used. The G–Vg curves show different degrees of hysteresis, with slower ramps 
showing larger hysteresis.
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Three representative gate voltage ramping conditions are simulated in this model, as 
shown in the table below, to be compared with Fig. 3 in Ref. 1.

In Ref. 1, the hexagonal InAs nanowire is approximated as an infinitely long cylinder to 
be modeled in 1D axial symmetric geometry. Comparing to the time scales of the voltage 
ramps, the carriers in the bulk are assumed to be instantaneously equilibrated, while the 
dynamics of the surface traps is simulated using time-dependent equations. In the tutorial 
model, on the other hand, everything is treated as time dependent and a grounded metal 
contact is placed at the center axis of the cylinder. This achieves the same instantaneous 
equilibrium for the carriers in the bulk.

In Ref. 1, the conductance is computed from the electron density divided by a weighted 
sum of the ionized surface trap densities to account for their scattering effects. The 
electron density is computed by summing quantized 1D subbands and the hole density 
using the bulk 3D formula. In the tutorial model, both carrier types are treated as bulk 
3D, and the density-gradient formulation is used to include the quantum confinement 
effect. In addition, the zero-density-gradient boundary condition of the density-gradient 
formulation at metal contacts helps maintaining a reasonable carrier density profile at the 
center axis of the cylinder.

The gate contact boundary condition in the model incorporates the effective oxide relative 
permittivity and effective oxide thickness using the formulas given in Ref. 1. The 
properties of the four different types of surface traps are all provided by the reference paper 
and entered into the model accordingly.

See the comments in the section Modeling Instructions for more detailed discussions on 
the model construction, solution processes, and result visualization.

TABLE 1:  GATE VOLTAGE RAMPING CONDITIONS SIMULATED IN THE MODEL

CONDITION 1 2 3

Ramp rate (dVdt) 44 uV/s 27 mV/s 27 mV/s

Initial voltage (V0) 6 V -4 V 6 V

Peak/Valley voltage (V1) -4 V 6 V -4 V
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Results and Discussion

Figure 1 shows the simulated conductance as a function of the gate voltage, to be 
compared with Fig. 3(a) and (b) in Ref. 1. The hysteresis and order of magnitude match 
reasonably well with the experiment and model results shown in the reference paper.

Figure 1: Conductance versus gate voltage curves.
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Figure 2 plots the Fermi level relative to the conduction band edge versus the gate voltage, 
to be compared with Fig. 3(c) in the reference paper. The general trend and order of 
magnitude match reasonably well.

Figure 2: Fermi level versus gate voltage.
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Application Library path: Semiconductor_Module/Transistors/
inas_nanowire_traps_hysteresis_density_gradient

Modeling Instructions

From the File menu, choose New.

N E W

In the New window, click Model Wizard.

M O D E L  W I Z A R D

1 In the Model Wizard window, Approximate the nanowire as an infinitely long cylinder 
using the 1D axial symmetric geometry.

2 click 1D Axisymmetric.

3 In the Select Physics tree, select Semiconductor > Semiconductor (semi).

4 Click Add.

Use the Semiconductor Equilibrium study step to simulate the initial condition of the 
experiment after the sample has been biased at a fixed gate voltage for a long time.

5 Click Study.

6 In the Select Study tree, select Preset Studies for Selected Physics Interfaces > 
Semiconductor Equilibrium.

7 Click Done.

G E O M E T R Y  1

The Model Wizard exits and opens the Model Builder desktop environment at the 
Geometry node. Set the length scale here right away.

1 In the Model Builder window, under Component 1 (comp1) click Geometry 1.

2 In the Settings window for Geometry, locate the Units section.

3 From the Length unit list, choose nm.

G L O B A L  D E F I N I T I O N S

Next, enter model parameters. Use separate Parameters nodes to organize the parameters 
in different categories, beginning with the nanowire parameters: the radius, length, 
temperature, and gate oxide parameters are from Ref. 1. The semiconductor material 
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parameters are guess values using bulk material properties. The series conductance is also 
a guess value which in the paper was a fitting parameter to account for other effects such 
as the contact resistances.

Parameters 1 - Nanowire FET
1 In the Model Builder window, under Global Definitions click Parameters 1.

2 In the Settings window for Parameters, type Parameters 1 - Nanowire FET in the 
Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

Hide these parameters from parameter selections, such as for parametric sweeps, to 
make it easier to set up the studies later with a smaller number of parameters to choose 
from.

Name Expression Value Description

R0 23[nm] 2.3E-8 m Radius of nanowire

L0 1.6[um] 1.6E-6 m Length of nanowire 
FET channel

mun0 4e4[cm^2/V/s] 4 m²/(V·s) Electron mobility

mup0 5e2[cm^2/V/s] 0.05 m²/(V·s) Hole mobility

epsr0 15.15 15.15 Relative 
permittivity

Eg00 0.354[V] 0.354 V Band gap

chi00 4.9[V] 4.9 V Electron affinity

Nc0 8.7e16[cm^-3] 8.7E22 1/m³ Conduction band 
effective density of 
state

Nv0 6.6e18[cm^-3] 6.6E24 1/m³ Valence band 
effective density of 
state

T0 300[K] 300 K Temperature

d_ox0 100[nm] 1E-7 m Thickness of gate 
oxide

d_ox d_ox0*
acosh((d_ox0+R0)/
R0)

2.361E-7 m Effective thickness 
of gate oxide

epsr_ox 2.12 2.12 Effective relative 
permittivity of gate 
oxide

G_s 50[uS] 5E-5 S Series conductance
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4 Click to expand the Visibility section. Clear the Show in parameter selections checkbox.

Next, enter the trap parameters from Ref. 1 in a new Parameters node and hide also these 
ones from study settings.

Parameters 2 - Surface Traps
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 2 - Surface Traps in the 
Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

4 Locate the Visibility section. Clear the Show in parameter selections checkbox.

Before entering the remaining parameters, define a triangle function to be used in the 
subsequent parameter definition for the ramping of the gate voltage.

Triangle 1 (tri1)
1 In the Home toolbar, click Functions and choose Global > Triangle.

2 In the Settings window for Triangle, locate the Parameters section.

Name Expression Value Description

Ds_tot 4e13[cm^-2] 4E17 1/m² Total trap density

Ds_f 1.6e12[cm^-2] 1.6E16 1/m² Fast trap density

Ds_s Ds_tot-Ds_f 3.84E17 1/m² Slow trap density

Ea0_f 0[mV] 0 V Emission barrier 
parameter of fast trap

Ea0_s 700[mV] 0.7 V Emission barrier 
parameter of slow trap

gamma0 1e6[1/s] 1E6 1/s Capture rate constant

Et0_a -400[mV] -0.4 V Center of acceptor trap 
energy level distribution 
below Ec (negative value 
means above Ec, that is, 
inside the conduction 
band)

Et0_d 300[mV] 0.3 V Center of donor trap 
energy level distribution 
below Ec

sig0 200[mV] 0.2 V Width of trap energy 
level distribution

gD0 2 2 Degeneracy factor
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3 In the Lower limit text field, type 0.

4 In the Upper limit text field, type 1.

5 Click to expand the Smoothing section. Clear the Size of transition zone checkbox.

Now define the parameters for the gate voltage bias conditions of the experiment. Use the 
triangle function to define the voltage sweep as a function of time: the gate voltage Vg is 
swept from V0 to V1 and then back to V0 at the ramp rate of dVdt. Leave this set of 
parameters visible for study settings.

Parameters 3 - Bias Conditions
1 In the Home toolbar, click Parameters and choose Add > Parameters.

2 In the Settings window for Parameters, type Parameters 3 - Bias Conditions in the 
Label text field.

3 Locate the Parameters section. In the table, enter the following settings:

To approximate the nanowire as an infinitely long cylinder using the 1D axial symmetric 
geometry, simply add a line interval with the length set to the radius of the cylinder R0.

G E O M E T R Y  1

Interval 1 (i1)
1 In the Model Builder window, under Component 1 (comp1) right-click Geometry 1 and 

choose Interval.

2 In the Settings window for Interval, locate the Interval section.

Name Expression Value Description

dVdt 44[uV/s] 4.4E-5 V/s Voltage ramp rate

V0 6[V] 6 V Initial and final 
voltage of triangular 
voltage ramp

V1 -4[V] -4 V Peak (or valley) 
voltage of triangular 
voltage ramp

t 0[s] 0 s Time parameter

t_max 2*abs(V1-V0)/dVdt 4.5455E5 s Duration of voltage 
ramp

Vg V0+(V1-V0)*tri1(t/
t_max)

6 V Gate voltage
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3 In the table, enter the following settings:

4 Click Build All Objects.

Add a blank material and enter the parameters for the semiconductor material properties 
defined earlier.

M A T E R I A L S

Material 1 (mat1)
1 In the Model Builder window, under Component 1 (comp1) right-click Materials and 

choose Blank Material.

2 In the Settings window for Material, locate the Material Contents section.

3 In the table, enter the following settings:

Coordinates (nm)

0

R0

Property Variable Value Unit Property group

Electron mobility mun mun0 m²/(V·s) Semiconductor 
material

Hole mobility mup mup0 m²/(V·s) Semiconductor 
material

Relative 
permittivity

epsilonr_iso ; 
epsilonrii = 
epsilonr_iso, 
epsilonrij = 0

epsr0 1 Basic

Band gap Eg0 Eg00 V Semiconductor 
material

Electron affinity chi0 chi00 V Semiconductor 
material

Effective density of 
states, conduction 
band

Nc Nc0 1/m³ Semiconductor 
material

Effective density of 
states, valence band

Nv Nv0 1/m³ Semiconductor 
material
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S E M I C O N D U C T O R  ( S E M I )

Now set up the physics. Enter the channel length parameter as the out-of-plane thickness. 
Choose Fermi–Dirac statistics and use the density-gradient formulation to add quantum-
confinement effect to the drift–diffusion equation system.

1 In the Model Builder window, under Component 1 (comp1) click Semiconductor (semi).

2 In the Settings window for Semiconductor, locate the Vertical Height section.

3 In the d text field, type L0.

4 Locate the Model Properties section. From the Carrier statistics list, choose Fermi–Dirac.

5 Click to expand the Discretization section. From the Formulation list, choose 
Finite element density-gradient (quadratic shape function).

Enter the temperature and some guess values for the density-gradient effective masses.

Semiconductor Material Model 1
1 In the Model Builder window, under Component 1 (comp1) > Semiconductor (semi) click 

Semiconductor Material Model 1.

2 In the Settings window for Semiconductor Material Model, locate the Model Input section.

3 In the T text field, type T0.

4 Locate the Material Properties, Density-Gradient section. In the me
DG text field, type 

me_const*0.03.

5 In the mh
DG text field, type me_const*0.4.

Use a metal contact boundary condition at the center of the cylinder to capture the effect 
of the source and drain contacts used in the experiment, which are located out-of-plane in 
the 1D axisymmetric geometry for this model. The zero-gradient boundary condition for 
the carrier concentrations at the metal contact as given by the density-gradient formulation 
is particularly suitable in the case to approximate the carrier density profile near the origin.

Metal Contact 1
1 In the Physics toolbar, click Boundaries and choose Metal Contact.

2 Select Boundary 1 only.

Add a gate contact boundary condition at the circumference of the cylinder, using the 
nanowire gate parameters defined earlier and some guess values for the density-gradient 
formulation of the potential barrier at the semiconductor–oxide interface.

Thin Insulator Gate 1
1 In the Physics toolbar, click Boundaries and choose Thin Insulator Gate.

2 Select Boundary 2 only.
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3 In the Settings window for Thin Insulator Gate, locate the Terminal section.

4 In the V0 text field, type Vg.

5 Locate the Gate Contact section. In the εins text field, type epsr_ox.

6 In the dins text field, type d_ox.

7 Locate the Density-Gradient section. From the Formulation list, choose Potential barrier.

8 In the me
Ox text field, type me_const*0.5.

9 In the me
Ox* text field, type me_const*0.22.

10 In the Φn
Ox text field, type 3[V].

11 In the Φp
Ox text field, type 3[V].

Ref. 1 used four kinds of continuous trap energy distributions to simulate the effect of 
traps at the semiconductor–oxide interface. This can be done in the model using a Trap-

Assisted Surface Recombination physics node with four Continuous Energy Levels subnodes. 
First add the parent physics node. Use the Trap occupancy formulation which works better 
for time-dependent studies.

Trap-Assisted Surface Recombination 1
1 In the Physics toolbar, click Boundaries and choose Trap-

Assisted Surface Recombination.

2 Select Boundary 2 only.

3 In the Settings window for Trap-Assisted Surface Recombination, locate the Trap-

Assisted Recombination section.

4 From the Trapping model list, choose Explicit trap distribution.

5 Locate the Trapping section. From the list, choose Specify continuous and/

or discrete levels.

6 Select the Specify trap species checkbox.

7 From the Formulation list, choose Trap occupancy.

Next, add the subnodes using the trap parameters for the fast acceptors defined earlier, 
except for the electron capture probability. Since the latter varies with the trap energy level, 
enter it later after having defined some relevant variables. In Ref. 1, the hole capture 
probability is assumed to be zero. Discretize the continuous trap energy distribution using 
100 levels as was done in Ref. 1. In this model the 100 levels are distributed within three 
standard deviations of the Gaussian distribution to efficiently cover the majority of the 
traps.
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Continuous Energy Levels - Fast Acceptor
1 In the Physics toolbar, click Attributes and choose Continuous Energy Levels.

2 In the Settings window for Continuous Energy Levels, type Continuous Energy Levels 
- Fast Acceptor in the Label text field.

3 Locate the Trap Type section. From the Trap type list, choose Acceptor traps.

4 Locate the Traps section. In the Nt text field, type Ds_f.

5 From the Distribution center point list, choose From conduction band edge.

6 In the Et,0 text field, type Et0_a.

7 In the σ text field, type sig0.

8 In the gD text field, type gD0.

9 In the Nxd
elem text field, type 100.

10 In the Et,min text field, type semi.tasr1.Ec0t-Et0_a-3*sig0.

11 In the Et,max text field, type semi.tasr1.Ec0t-Et0_a+3*sig0.

12 Locate the Carrier Capture section. From the Probability of electron capture list, choose 
User defined. From the Probability of hole capture list, choose User defined. In the Cp 
text field, type 0[cm^3/s].

Duplicate the subnode to reuse most settings for the fast donors. Enter the settings that 
are different for the fast donors: the trap type and the parameter for the center of the trap 
distribution.

Continuous Energy Levels - Fast Donor
1 Right-click Continuous Energy Levels - Fast Acceptor and choose Duplicate.

2 In the Settings window for Continuous Energy Levels, type Continuous Energy Levels 
- Fast Donor in the Label text field.

3 Locate the Trap Type section. From the Trap type list, choose Donor traps.

4 Locate the Traps section. In the Et,0 text field, type Et0_d.

5 In the Et,min text field, type semi.tasr1.Ec0t-Et0_d-3*sig0.

6 In the Et,max text field, type semi.tasr1.Ec0t-Et0_d+3*sig0.

Similarly, duplicate the subnodes to reuse most settings and enter the setting that is 
different between the fast and slow traps: trap number density.

Continuous Energy Levels - Slow Acceptor
1 In the Model Builder window, right-click Continuous Energy Levels - Fast Acceptor and 

choose Duplicate.
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2 In the Settings window for Continuous Energy Levels, type Continuous Energy Levels 
- Slow Acceptor in the Label text field.

3 Locate the Traps section. In the Nt text field, type Ds_s.

Continuous Energy Levels - Slow Donor
1 In the Model Builder window, right-click Continuous Energy Levels - Fast Donor and 

choose Duplicate.

2 In the Settings window for Continuous Energy Levels, type Continuous Energy Levels 
- Slow Donor in the Label text field.

3 Locate the Traps section. In the Nt text field, type Ds_s.

D E F I N I T I O N S  ( C O M P 1 )

Now define variables for the electron capture probability, which depends on the trap 
energy level. The dependence is based on an energy barrier between the trap level and the 
conduction band edge as formulated in Ref. 1. Since the density-gradient formulation 
reduces the electron density at the semiconductor–oxide interface as the result of quantum 
confinement, but the actual electron flux should not be reduced by the same factor, a 
factor Nfac with a guess value of 10 is introduced to compensate for the reduced electron 
density.

Variables 1 - Capture Probabilities
1 In the Model Builder window, under Component 1 (comp1) right-click Definitions and 

choose Variables.

2 In the Settings window for Variables, type Variables 1 - Capture Probabilities 
in the Label text field.

3 Locate the Variables section. In the table, enter the following settings:

Name Expression Unit Description

dE_fa semi.tasr1.ctb1.Vxd-
semi.tasr1.Ec0t

V Fast acceptor trap 
energy level relative to 
conduction band edge

dE_fd semi.tasr1.ctb2.Vxd-
semi.tasr1.Ec0t

V Fast donor trap energy 
level relative to 
conduction band edge

dE_sa semi.tasr1.ctb3.Vxd-
semi.tasr1.Ec0t

V Slow acceptor trap 
energy level relative to 
conduction band edge

dE_sd semi.tasr1.ctb4.Vxd-
semi.tasr1.Ec0t

V Slow donor trap energy 
level relative to 
conduction band edge
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S E M I C O N D U C T O R  ( S E M I )

Enter the electron capture probabilities defined above into the physics settings.

Continuous Energy Levels - Fast Acceptor
1 In the Model Builder window, under Component 1 (comp1) > Semiconductor (semi) > 

Trap-Assisted Surface Recombination 1 click Continuous Energy Levels - Fast Acceptor.

2 In the Settings window for Continuous Energy Levels, locate the Carrier Capture section.

3 In the Cn text field, type Cn_fa.

Continuous Energy Levels - Fast Donor
1 In the Model Builder window, click Continuous Energy Levels - Fast Donor.

2 In the Settings window for Continuous Energy Levels, locate the Carrier Capture section.

3 In the Cn text field, type Cn_fd.

Continuous Energy Levels - Slow Acceptor
1 In the Model Builder window, click Continuous Energy Levels - Slow Acceptor.

2 In the Settings window for Continuous Energy Levels, locate the Carrier Capture section.

Eb_fa dE_fa+max(-dE_fa,
Ea0_f)

V Fast acceptor trap 
capture barrier

Eb_fd dE_fd+max(-dE_fd,
Ea0_f)

V Fast donor trap capture 
barrier

Eb_sa dE_sa+max(-dE_sa,
Ea0_s)

V Slow acceptor trap 
capture barrier

Eb_sd dE_sd+max(-dE_sd,
Ea0_s)

V Slow donor trap capture 
barrier

Nfac 10 Compensation factor for 
electron flux

Cn_fa gamma0/Nc0*exp(-Eb_fa*
e_const/k_B_const/T0)*
Nfac

m³/s Fast acceptor trap 
electron capture 
probability

Cn_fd gamma0/Nc0*exp(-Eb_fd*
e_const/k_B_const/T0)*
Nfac

m³/s Fast donor trap electron 
capture probability

Cn_sa gamma0/Nc0*exp(-Eb_sa*
e_const/k_B_const/T0)*
Nfac

m³/s Slow acceptor trap 
electron capture 
probability

Cn_sd gamma0/Nc0*exp(-Eb_sd*
e_const/k_B_const/T0)*
Nfac

m³/s Slow donor trap electron 
capture probability

Name Expression Unit Description
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3 In the Cn text field, type Cn_sa.

Continuous Energy Levels - Slow Donor
1 In the Model Builder window, click Continuous Energy Levels - Slow Donor.

2 In the Settings window for Continuous Energy Levels, locate the Carrier Capture section.

3 In the Cn text field, type Cn_sd.

D E F I N I T I O N S  ( C O M P 1 )

Define variables for the conductance using the formula given in Ref. 1 to account for the 
ionized impurity scattering effect. First define coupling operators to access the trap 
variables at the gate and to integrate the computed conductance over the modeling 
domain. Then define the variables.

Integration 1 - Access Trap Variables at the Gate
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Integration 1 - Access Trap 
Variables at the Gate in the Label text field.

3 Locate the Source Selection section. From the Geometric entity level list, choose 
Boundary.

4 Select Boundary 2 only.

5 Locate the Advanced section. Clear the Compute integral in revolved geometry checkbox.

Integration 2 - Integrate Over the Cylinder
1 In the Definitions toolbar, click Nonlocal Couplings and choose Integration.

2 In the Settings window for Integration, type Integration 2 - Integrate Over the 
Cylinder in the Label text field.

3 Locate the Source Selection section. From the Selection list, choose All domains.

Variables 2 - Conductance
1 In the Model Builder window, right-click Definitions and choose Variables.

2 In the Settings window for Variables, type Variables 2 - Conductance in the Label 
text field.
16 |  S U R F A C E - T R A P - I N D U C E D  H Y S T E R E S I S  I N  A N  I N A S  N A N O W I R E  F E T  —  A  D E N S I T Y -



3 Locate the Variables section. In the table, enter the following settings:

S T U D Y  1  -  T W O  F A S T  A N D  O N E  S L O W  G A T E  V O L T A G E  R A M P S

The default mesh works fine for this model so you can proceed directly to setting up the 
studies. Use an outer Parametric Sweep to run two fast and one slow gate voltage ramps 
as in the abstract panel of Ref. 1.

1 In the Model Builder window, click Study 1.

2 In the Settings window for Study, type Study 1 - Two Fast and One Slow Gate 
Voltage Ramps in the Label text field.

Parametric Sweep
1 In the Study toolbar, click Parametric Sweep.

2 In the Settings window for Parametric Sweep, locate the Study Settings section.

3 Click Add three times.

Name Expression Unit Description

NAm -
intop1(semi.tasr1.ctb1.r
ho_tr+
semi.tasr1.ctb3.rho_tr)/
e_const

1/m² NA- : Ionized acceptor 
trap density

NDp intop1(semi.tasr1.ctb2.r
ho_tr+
semi.tasr1.ctb4.rho_tr)/
e_const

1/m² ND+ : Ionized donor trap 
density

G_0 intop2(mun0*semi.N)*
e_const*Ds_tot/(NDp+30*
NAm)/L0

S Channel conductance

G 1/(1/G_0+1/G_s) S Total conductance
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4 In the table, enter the following settings:

Note that the list in the Parameter name column is populated only with the last set of 
parameters, as set up earlier.

Add a time-dependent step to run the transient study.

  Step 2: Time Dependent
1 In the Study toolbar, click Time Dependent.

2 In the Settings window for Time Dependent, locate the Study Settings section.

3 In the Output times text field, type range(0,0.01,1)*t_max.

4 In the Study toolbar, click Compute.

R E S U L T S

Net Dopant Concentration (semi)
Because the model has no doping profiles defined, the default plot of net dopant 
concentration is not needed.

1 In the Model Builder window, under Results right-click Net Dopant Concentration (semi) 
and choose Delete.

Create a G–Vg plot to compare with the simulation and experimental results of Ref. 1. We 
find a good match of both the qualitative hysteresis behavior and the order of the 
magnitude of the conductance. Use the model-tree node label as the plot title.

G-Vg curves
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type G-Vg curves in the Label text field.

3 Locate the Data section. From the Dataset list, choose Study 1 -

Two Fast and One Slow Gate Voltage Ramps/Parametric Solutions 1 (sol3).

4 Click to expand the Title section. From the Title type list, choose Label.

5 Locate the Legend section. From the Position list, choose Upper left.

Parameter name Parameter value list Parameter unit

dVdt (Voltage ramp rate) 44[uV/s] 27[mV/s] 27[mV/
s]

mV/s

V0 (Initial and final voltage of 
triangular voltage ramp)

6 -4 6 V

V1 (Peak (or valley) voltage of 
triangular voltage ramp)

-4 6 -4 V
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Global 1
1 Right-click G-Vg curves and choose Global.

2 In the Settings window for Global, locate the y-Axis Data section.

3 In the table, enter the following settings:

4 Locate the x-Axis Data section. From the Parameter list, choose Expression.

5 In the Expression text field, type Vg.

6 Click to expand the Legends section. Find the Include subsection. Clear the Description 
checkbox.

7 In the G-Vg curves toolbar, click Plot.

Create an Ef–Vg plot to compare with the simulation results of Ref. 1. We again find a 
good match of both the qualitative hysteresis behavior and the order of the magnitude of 
the nonequilibrium Fermi level relative to the conduction band edge.

Ef-Ec vs. Vg
1 In the Results toolbar, click 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Ef-Ec vs. Vg in the Label text field.

Expression Unit Description

G uS Total conductance
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3 Locate the Data section. From the Dataset list, choose Study 1 -

Two Fast and One Slow Gate Voltage Ramps/Parametric Solutions 1 (sol3).

4 Locate the Title section. From the Title type list, choose Label.

5 Locate the Legend section. From the Position list, choose Lower right.

Point Graph 1
1 Right-click Ef-Ec vs. Vg and choose Point Graph.

2 Select Boundary 2 only.

3 In the Settings window for Point Graph, locate the y-Axis Data section.

4 In the Expression text field, type semi.Efn-semi.Ec.

5 Select the Description checkbox. In the associated text field, type Efn-Ec.

6 Locate the x-Axis Data section. From the Parameter list, choose Expression.

7 In the Expression text field, type Vg.

8 Click to expand the Legends section. Select the Show legends checkbox.

9 Find the Include subsection. Clear the Point checkbox.

10 In the Ef-Ec vs. Vg toolbar, click Plot.

A D D  S T U D Y

Add a study to compute the equilibrium Fermi level relative to the conduction band edge 
to add to the Ef–Vg plot to compare with the simulation results of Ref. 1.

1 In the Home toolbar, click Add Study to open the Add Study window.

2 Go to the Add Study window.

3 Find the Studies subsection. In the Select Study tree, select 
Preset Studies for Selected Physics Interfaces > Semiconductor Equilibrium.

4 Click the Add Study button in the window toolbar.

5 In the Home toolbar, click Add Study to close the Add Study window.

S T U D Y  2  -  E Q U I L I B R I U M

1 In the Settings window for Study, type Study 2 - Equilibrium in the Label text field.

2 Locate the Study Settings section. Clear the Generate default plots checkbox.

Step 1: Semiconductor Equilibrium
1 In the Model Builder window, under Study 2 - Equilibrium click 

Step 1: Semiconductor Equilibrium.
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2 In the Settings window for Semiconductor Equilibrium, click to expand the 
Study Extensions section.

3 Select the Auxiliary sweep checkbox.

4 Click Add.

5 In the table, enter the following settings:

6 In the Study toolbar, click Compute.

R E S U L T S

Point Graph 2
1 In the Model Builder window, under Results > Ef-Ec vs. Vg right-click Point Graph 1 and 

choose Duplicate.

2 In the Settings window for Point Graph, locate the Data section.

3 From the Dataset list, choose Study 2 - Equilibrium/Solution 7 (sol7).

4 Click to expand the Coloring and Style section. Find the Line style subsection. From the 
Line list, choose Dashed.

5 From the Color list, choose Black.

6 Locate the Legends section. Find the Prefix and suffix subsection. In the Prefix text field, 
type Equilibrium.

Parameter name Parameter value list Parameter unit

Vg (Gate voltage) range(-4,1,6) V
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7 In the Ef-Ec vs. Vg toolbar, click Plot.

The results are similar as expected.
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